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Introduction

This Quick Start Guide is designed
to give you an overview of the
main features of Reuters EcoWin
Pro, equipping you with basic
knowledge of how the software
works, and what it can do for you.
Many of the areas covered in the
overview can be followed up in
greater depth using the online
help documentation.

Reuters EcoWin Pro operates in a Windows
environment. This means there is consistency in
menus, commands and dialog boxes. You will find a
standardized toolbar containing buttons consistent
with Windows. With the Excel Add-in you can easily
download and export data to Microsoft Excel and
update your spreadsheets.

Welcome to Reuters EcoWin Pro E

REUTERS ) Ecowin Pro

& Create a Basic Chart

‘ . Create document using a Study

E—:? Open a Saved Document

@ G0 ko the Eco'win Pro Start page

l Conkinue ko use EcoWin

Recent documents

Help

Reuters EcoWin Pro contains comprehensive help
documentation. Within the documentation, you
will find descriptions, definitions, formulas and
examples. Simply mark an item and press F1 on
your keyboard.

Welcome to Reuters EcoWin Pro
When opening Reuters EcoWin Pro from the
program menu, a dialog box will appear showing
several options for using Reuters EcoWin Pro.

Create a Basic Chart — Create a chart directly by
selecting time series.

Create Document Using a Study — Open a pre-
installed study template for your document.

Open a Saved Document — Open a previously
saved EcoWin Pro document.

Go to the EcoWin Pro Start Page — Access the
EcoWin Pro Start page directly.

Continue to Use EcoWin — Access all options
mentioned above from here.

flways show this dislog when the program is started:

o Reuters EcoWin Pro — Quick Start Guide



Toolbar

Reuters EcoWin Pro
Eile Edit Wiew Insert Chart Analysis Tools Window Help

=10 ]
=181 x|

|RIEID] > w] $BIB[X] D] S| 2 (3] ][ tose chortstvie

HINNNEEREETD |

New document with chart
New study

Formula editor

E =B =

Series information

Hide/show Property bar
Add series

Duplicate series

B ¥ ¥ B

Presentation settings

|- Losd chartstyle — | [oad chart style

Menus

File - Contains administrative features such as
Saving, Printing, Settings, Series Editor and the
Binder.

Edit - Includes copy commands, which you can

use to move/copy documents or data into other
applications. Reuters EcoWin Pro supports both
OLE and DDE links. The Undo option can be found
here.

View - Deactivate the Legend, the analysis shown in
the Legend or multiple columns in the Legend. You
can also find the Ruler command here.

Insert - Allows the user to insert Text labels, Arrows,
Lines and multiple Panes.

Chart - Commands related to the formatting of
your chart, such as Graph layout, Chart settings,
Horizontal axis, Main vertical axis, Alternate vertical
axis, Info box settings and Load styles.

Insert arrow

Insert line

Insert vertical line
Insert horizontal line

Insert text

B = E =

Reuters EcoWin Pro Start page
Chart Library

& & ke

Help

Analysis - Contains Save as series, Calculation
range, and the Insert menu which shows all the
available analysis methods.

Tools - Provides utilities to administer (configure,
repair, backup) your database.

Window - Cascade, Tile and Arrange Icons are
commands for organizing your documents on the
screen. The Set size command is also available
here, as well as the command Restore floating bar
position.

Help - Content includes Help Topics, Recent News,
Check for new version, a link to the Reuters EcoWin
Pro Start page and Contact us.
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2 Creating a New Chart

Il Select Series N

Database IEcoWin Database jl

Tree Search ] Test Search] Equities]

Sources Frequency

IECDW'in Financial j : ﬂ
Wigw

IAII Countries j

To create a new chart, select the Create a basic chart option from the start dialog box or the New
document with chart button in the toolbar. The Select Series box will then appear.

; {1 United Arab Emirates ;I
United Kingdom
1% United States
7 Bond Indices
Bond Market
Auction Results
Bond Futures
Constant b aturity ields

|nflation-ind L 10% ge, IS0

Series Mame | Frequency | Start [ &
Constant M aturity Inflation-indexed, 10 Vear, Yield, Close, USD Day 2003-C
Constant M aturity Inflation-indexed, 20 Year, Breakeven Inflation, Cloze, USD Day 2004-C
Constant M aturity Inflation-indexed, 20 Vear, Yield, Cloge, USD Day 2004-
Constant M aturity Inflation-indexed, 5 'ear, Breakewven Inflation, Close, USD Day 1997-C
Constant M aturity Inflation-indexed, 5 ear, Yield, Cloze, USD Day 1997-C
Constant M aturity Inflation-indexed, 7 ear, Breakewven Inflation, Close, USD Day 2003-C
Constant b aturity Inflation-indexed, 7 Year, Yield, Close, USD

D ay 2003-C

Day 1997.C

Corporate Benchmarks [ Inflation-indexed, ‘IYear, “ield, Cloze, SD
Default B ates Inflation-indexed, 20 Year, Yield, Average, USD Manth 2004:7
(e B elrets Inflation-indexed, & Year, Yield, &verage, USD Maonth 20031
| il Govemment Bonds ___[Qffj Inflaionindesed. 7 Year. Vie. fverage. USD____ Moth | 200 I
| | » <] i »
[ Favorites anly [lpdate | Series Info | Add |
r~ Selection List
Series Mame | Frequency | Start Date | 1D |
Inflation-indexed, 10 Year, Yield, Average, USD Maonth 20031 ewruzal 4057
Hemove | Remave Al |
Help Copyright € 2005 Reuters Ltd. Al rights rezerved. | ak. | Cancel |

1. Select database and source 2.
First specify whether you want
to look in the EcoWin database
or your In-house database. Then
select the database source:
EcoWin Financial or EcoWin
Economic. The add-on databases
to which you subscribe will also
appear here.
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Add series to the Selection List 3.
In the Tree View you will find the

time series sorted by different

views, such as countries and

categories, for example. Time

series are sorted by different levels

in order to make searching easier.
Select a time series by double-

clicking on it or by marking it and

then clicking the Add button.

Create your chart

All series you have selected in
the previous steps are shown

in the Selection List. When you
have added all series you want to
present in your document, click
the OK button to create your
chart.



Saving Your Chart

Using the Save As option in the File menu, you can These documents can be retrieved at any time, by
save documents consisting of charts, tables and clicking on the Open button. The documents will _""l
reports in your own file library. be updated automatically when new values are

entered into the databases.

"® Reuters EcoWin Pro - [EcoWinl.ewg]
m File Edit Yiew Insert Chart Analysis Tools Window Help
| BIE]O] 3] XX ] D] SfE 3] 2 [S]]|F- oo chartsvie — =] NIN| 1 =] || ]3] @]
analyses | United States, Government Benchmarks, Inflation-indexed
. o 10 Year, Yield, Average, USD
@ Before 7 After 26 {United States, Government Benchmarks, Inflation-indexed, 10 Year, Yield, Average, USD 2,26\
Time chart Table 25
£ Arithmetic ﬂ Performance :
92 Rate of change éRebase 2,4 k
-« Smoathing = Mean |
% Trend 23
22
Mare P |
2 ) O g 2'1 ]
ﬁ Series lisk % 2,04
- o qg]
1.8
1.7
1.6 -
15
14 4
T T T | T T T |I T T | T T T | T T
jan maj sep Jan maj sep jan maj sep jan mal sep jan
03 04 05 06 o7
Source: Reuters EcoWin
| 4

The EcoWin series are presented, by default, as a line chart along with the Analyses tree to the left.
In-house databases or any other data sources are based on the same principle, which means that time series from
different databases can be combined freely.
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3 Selecting Series

2 =

Using Select Series

Data is selected from the Select Series box. There
are several ways to access this box in Reuters
EcoWin Pro. If you have already started Reuters
EcoWin Pro, a new chart can be created using the
New document with chart button in the toolbar.

If you have not decided what output you would like,
select the New button in the toolbar, then access
the Select Series box using the Add Series button.
This button can also be used if you want to add
series to an existing document.

Il Select Series i x|

Database IEcoWin Database - I

Q—' Tree Search | Text Searchl Equities I|

Series can be duplicated using the Duplicate
series button in the toolbar.

The Tree View is the default search engine in
Reuters EcoWin Pro. The filter function can be used
to further refine your series selection. However, the
properties of this function may vary from database
to database. You can also personalize Select Series
by using the Favorites function so that only the
countries and categories you are interested in are
displayed.

SoUces Frequency Tems Trend
IECUW'in E conomic j I" j I" j I" j
Wigw Seazonal Adj. Calendar Adj. Annual R ate e
IEountries j I" j I" j I" j
(=15 United States ;I Series Mame | Start Date
: 7 Balance of Payments Cluarter 0051 S
—1- 7 Current Account Cuarter 1986:1 evuzal B
A Guarter _|
= GZoagsceand Servi | Evropean Lrion, ["Guarer | B L4 3
Eoa L Goods. Servi , France, USD Quarter 2005: ewuzal 8000700
oL Goedsseniees o | Ttal, Gemany, USD Duarter 20051 ewrusal 8000300
‘:I o e "I e v Tatal, Hong Kong, USD Cuarter 20051 ewuzal 2002000 =
[T Fawvorites orly | pdate I Series Info | m——e
Selection List
Series Name | Frequs._ncy | Start Date | 1D
iTotal, Euro area, USD Luarter 2005:1 ewuzal 000500 §
Total, Europe, USD Quarter 1360:1 ewusal 8287 1
Total, European Union, USD Guarter 15986:1 evruzal 8203
Bemove | Remave Al |
Help | ak. | Cancel |

4

A. Search for series
Series can be found by using the
Tree, Text, or Equities search.
The Equities search tab is only
available if you subscribe to the
EcoWin Equities database.
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B. Filter
Fine-tune your series selection
with filters.

C. Add series
You can add series to the
Selection List here.

D. Selection List
The Selection List allows you to
browse and choose multiple series
from different categories and
databases, without having to close
the Select Series box.

#|



Text Search

Data can also be found using the Text Search. The
Text Search searches the databases marked in the
sources list when you click the Search button or
Enter key. You can use the booleans and, or when
searching. Without these booleans, the search will
use and by default. Evaluation takes place from left
to right only.

By pressing down the Ctrl or Shift keys, you can
select multiple data sources from which to search.

The Text Search searches using the series’ full
descriptions and source as well as all the other
meta data associated with the series, except the
commentary and frequency. You can use the
frequency filter to narrow your search further.

A maximum of 300 hits are returned. The search will
not return any discontinued series.

x
Database IEcoWin Database 'l
Tree Search  Text Search | Equitiesl
Sources Search Result
| _ Series Mame [32 time series found Start D ate
Ecawin Equities i ier P il anth
gans obeniIand United States, Consumer Prices, New cars, 54, [ndex Month 19531 ewuzal 18!
Bﬂreaejo?gconomic Analysis France, Consumer Prices, Mew and used cars, [ndex Month 19981 ewfrallgs,
i = Ausztria, New Orders, Cars and autoparts, ELIR Month 15936:1 e autE0z
BureatiokLabor stalistics _I Ireland, Congumer Prices, By Commodity, Transport, Mew ... Maonth 158311 ewril11610
Estonia, Mew Passenger Car Registration, Mew cars Maonth 195971 e eek080;
Frequency France, Buziness Surveys, Retail Sector, Cars, new, Const... Month 19871 ev:fral4001
France, Buginess Surveys, Retail Sector, Cars, new, Congt... Maonth 19871 ey fral4 00!
IAn}' j France, Business Surveys, Retail Sector, Cars, new, Curre... . Month 13871 e fral400i
France, Buginess Surveys, Retail Sector, Cars, new, Curre...  Maonth 19871 e fral4 00!
Search Test Mew Zealand, Imparts, Other categories, passenger mator ... Month 13381 ewnzl1 712
South Africa, Mew Vehicles, Domestic Sales, Passenger c... Month 20031 e zar1850
INEW cars South Africa, Mew Vehicles, Exports, Passenger cars Maonth 20031 ew:zarDSSDLI
Search | Select Al Desslect &l Series Info | add |
i~ Selection List
Series Mame | Frequency | Start Date | 1D
Hemove | Femoyve &l |
Help | [k | Cancel |
4
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Equities Selection

The Equities tab is available if you subscribe to
the EcoWin Equities database and offers a more
efficient way of searching for companies.

The EcoWin Equities database lets you tap directly
into an accurate, comprehensive and up-to-date

source of equity-related data.

This database gives you access to worldwide
balance sheets, income statements and cash flow
statements, as well as key ratios, global equity
prices, quarterly fundamentals, world equity
indices, and more.

x|
Database |Ecowin Database ']
Tree Search ] Text Search  Equities ]
Categories | Keywordsl
Companies by Country j Company [436 entries found] | |

- = ElektronikGruppen SE

Euszl.aA i —I Elverket Vallentuna 4B SE
Bl Emiter Holding AB SE
- Singapore EneaData SE
- Slovak Republic Enira SE
- Slovenia Enlight 48 SE

0_ - South Africa w 3E J __e

- South Korea European Institute of Science SE
PR Eurovip Group 4B SE

gpalz Expanda SE
AR, J Fabege SE
- Switzerland Fagerhult SE
- Taivan Fast Partner SE
- Thailand Fastighets AB Balder SE
- Tunisia LI Feelgood Svenska SE &

C - b mme cC
Lookup Chooze. .. All ‘ Mone ‘ Irvert ‘
1 Selection List
Series Mame Frequency Start D ate 1 18] 1
Sweden, ERICSS0N ORD, Close Dray 15987-01-02 eqenc_b_st_cl
Sweden, ERICSS0M ORD, High Day 1987-01-02 eqenc_b_st_hi
Sweden, ERICS50N ORD, Low Dray 15987-01-02 eqenc_b_st_lo
Sweden, ERICS50N ORD, Open Dray 19511119 eqenc_b_st_op
] Remave Al ‘
Help Copyright 2 2005 Reuters Ltd. Al ights reserved. ok ‘ Cancel |

1. Choose Category

Choose the category you want to search from the

drop-down menu.

Mark the country in which you are interested and
click the Lookup button. All companies listed for this
country will now be shown in the Company window.

@ Reuters EcoWin Pro — Quick Start Guide

2. Select Time Series
Mark the companies of interest and click the Choose
button. A new window will now open.
Companies will appear in a tree structure in the Select
Time Series window. If this structure is expanded, all
variables for these companies will be shown.



Series List

The Series List is where all your selected series
are located. In order to convert Frequency, set
Calendar or make Currency conversions for your

selected series, go to the Series List and make your
changes.

A.

(C)

"i" Reuters EcoWin Pro - [EcoWinl.ewg] =10l x|
ID File Edit Analysis Tools ‘Window Help ;Iilll
| BICID] W] x[B|TX] D] JO EINNNEEEEE

e | | Series and Folnulas |F0re.casts | Corwarsion settings ||

TR |Frequency Include points of observation where data is available For| | Currency
fmi‘ & e ||M0nth j IAny series j INone 'l
efore %) After
Time chart [ Table TrEreiEEe

£ Arithmetic ﬂ Performance

22 Rate of change é Rebase Copy

o Smoathing = Mean Paste

% Trend 4 Formula Delete
Select Al

Mare [» |
Faste Link

T : Add series...

----- 5 Seties list ) _

Duplicate series
v Auto G

Custom
Mame
Description

2l

Fit Widkh

Ready

ed States, Government Benchmarks, Inflation-indexed, 10 ear, ield, Awver

Full description

Select columns. ..

Changing Frequency
Convert frequency for all series in the Series List by
selecting any of the preset frequency periods.

. Forecasts

You can extend any time series in the document with
your own future values for use in all calculations and

B. Calendar presentations.
The Calendar determines how Reuters EcoWin Pro will . Conversion Settings
handle missing values. You can make more advanced decisions regarding
Any series includes all observations where there is at frequency conversions and the handling of missing
least one observation in any series. values using Conversion settings.
All series is used if one of the times series in the Series Right-click Menu
List has a missing value. If so, that specific date/ Right-clicking on the series ID or the internal label of a
observation will be removed for all the time series. series will bring up a drop-down menu.
Calendar includes all observations regardless of Any series can be copied, deleted, added, or
missing values in any series. duplicated from here. You can also select which

C. Currency columns to view and make changes to the series label

Convert currency for all series in the Series List by
selecting any of the preset currencies.

from this menu. Custom labels can be propagated to
charts and tables.
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4 Creating an Output

Reuters EcoWin Pro gives you several options The other output alternatives are Scatter chart,
for presentation of the data. We have already Table and Report.
mentioned the possibility of creating a Time chart.

"™ Reuters EcoWin Pro - [EcoWinl.ewg] : :LEIQ__[,)S[
m File Edit Analysis Tools ‘Window Help ;Iilll

| BICIO] M| $[O[O[X] F[®] Jo s [#[o][]] I NIN =[] ¢l el

Seties and Formulas |F0recasts I Conversion settings I

Analyses |
r Frequency Include points of observation where data is available for — Currency
Add analy O I J I J
Month - ANy series - Mone i
© Before 9 After —
[E] Time: chart [ Table
£ Arithmetic ﬂ Performance
92 Rate of change é Rebase Series or formula |Internal label
= Smoathing = Mean ewiuzal 4057 United States. Government Benchmarks, Inflation-indexed, 10 ear. Yield. Awvd
% Trend
Mare B |
@
Ll
Copy,
Faste
Faste affer
Rename
Time chark
Delete [] 5eatter chart
[ Table | v
Report
Transformations  » 4
Simulation 3
Statistics 3
Flow 3
Miscellaneous 3
Time chart A standard Time chart is displayed Table A Table shows the dates and the
as a plotted line. A number of m values for the time series, as well as
additional chart layouts are for the output of the analyses.

possible. A group of series can
be represented as a bar group, a
stacked bar group, an area group,
an open-high-low-close group, a

stripe group or a candlestick group.

Report In a Report you will find information
about the time series, for instance,
source and description. If a
regression analysis is added, a
statistical report is generated

Scatter chart The Scatter chart shows the values automatically.
for two time series plotted against
each other.
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EcoWin studies are pre-formulated, editable
algorithms that operate on the series, frequency,
and other parameters that you provide. Depending
on the particular study, the results may be charts,
plots, reports, or diagrams.

Studies are available from the File menu or the New
Study button in the toolbar.

Study types

Several types of studies are supported, and can be
selected from the New Study dialog, as illustrated
below:

New Study %]
Select the bype of Study document to create
El (23 Studies

[=1-(Z1] Ecoiwin

----- s Aggregates
----- ‘.= Change over period
----- ‘.~ Best lag regression
[=-[C) Fan charts

s User data
I Parametric

A series future distribution is
simulated in a geometric model
where random gross rates of
changes are boot-strapped from
empirical historical distribution,

----- ‘- GDP weighted real vield

----- '~ Prices and volume

----- '~ Regression modeling

----- ‘- RiskfReturn

----- = Scatter plot with best fit

----- ‘= Series distribution hiskogr am
----- '~ Standardization

----- ‘= Standard vield curve

Study documentation

OF I Cancel | Help |

Aggregates

Allows you to create GDP (gross domestic product)
weighted aggregates or indices. The variables that
can be aggregated contain, for example, equity
index and consumer price index.

Change over Period

Allows you to create a chart where up to five time
series can be transformed into their corresponding
change over period series. There is, in addition, an
option for smoothing the change over period.

5 Using Studies

The output displays the transformed variable(s) in a
chart and in a table.

Best Lag Regression

Finds the lag at which the independent variable has
maximum correlation with the dependent variable.
A simple regression forecast with the accordingly
lagged independent variable is created.

Fan Chart — User data
Fan chart for a series is created from bands entered
as document data.

Fan Chart — Parametric

A series future distribution is simulated in a
model where random changes are sampled from
distribution functions.

Fan Chart — Bootstrapped

A series future distribution is simulated in a
geometric model where random gross rates of
changes are bootstrapped from empirical historical
distribution.

GDP Weighted Real Yield
Allows you to build an aggregate real yield for
Government Benchmark Bonds.

Prices and Volume

Allows you to pick a closing price for an equity, for
which the study will find the corresponding high,
low, and open prices, and the volume traded for
that equity.

Regression Modelling

The Regression Modeling study allows you to
estimate a number of linear regression models
for a given dependent variable that you want to
describe, explain and forecast.
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Risk/Return

Allows you to quickly get an overview of the

risk and return characteristics for a number of
series. All input data series are transformed into a
common form prior to the risk and expected return
calculations.

Scatter Plot with Best Fit

Allows you to produce a scatter chart with a line of
best fit and a standard deviation band around the
line of best fit.

Series Distribution Histogram
Calculates the distribution histogram and the
cumulative distribution function for a series.

Standardization

Allows you to select one or more time series and,
for each series, a separate time chart depicting the
time series, the mean of the time series, and the
standardized time series will be created.

Standard Yield Curve
Allows you to easily create yield curves for any
country in the database.

"* Reuters EcoWin Pro - [Eurozone consumer price index]
Eile Edit Wiew Insert Chart Analysis Tools Window Help

| BIEID] 3] S]] D] Sfm ] Z]E]|[J- oo chert ate —

HNNNEEEED

study | Euro Zone, Consumer Prices, All ltems, Total (ECB), SA, Index

Parametric fan chart 225

Settings

Fan chart; 200
{2

o

o
150

o

=

(o]

1251

100

75

92 94 96 98

Study documentation

Source: Reuters EcoWin

4

A fan chart produced using the Parametric Fan Chart Study.
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6 Using Charts in Office Applications

Itis possible to copy any chart in Reuters EcoWin
Pro using Edit, Copy chart picture and object.
These charts can be automatically or manually
updated in Office applications.

Paste Link | EcoWin Document Object

In order to access this option, the original EcoWin
document needs to be saved. Only a link to the
original document is saved in the Office document.
This link will be broken if the original document is
moved, deleted or not accessible for some reason.
Applying an analysis or renaming a chart in the
EcoWin document will also break the link. When
double-clicking an EcoWin document in an Office
application, it will open in Reuters EcoWin Pro.
Since the document is linked, you can use the Edit,
Links menu to update links and select automatic or
manual update.

Anyone who does not have Reuters EcoWin Pro
installed will be able to open documents with linked
EcoWin objects. However, they will not be able to
update, edit or open the chart object.

Paste | Picture (Enhanced Metafile)

This option creates a static picture of the chart; one
that will never be updated. You can only manipulate
it using standard Office tools. Right-click the picture
to use Format picture. If you are not able to use
Enhanced metafile, the problem might be that this
function has been disabled in the Reuters EcoWin
Pro application (located in the File menu, under
Settings, Options, Chart).

Paste | EcoWin Document Object

(Embedded Object)

Pasting the complete EcoWin document into an
Office application will create an embedded object.
It will be updated when it is double clicked and you
will have access to most of Reuters EcoWin Pro’s
menus while still inside the Office application. It is
also possible to update the chart by right-clicking it
and selecting EcoWin Document Object, Update.

Anyone who does not have Reuters EcoWin Pro
installed will be able to open documents with
embedded EcoWin objects. However, they will not
be able to update, edit or open the chart object.

Paste EcoWin document object is the general
default if you use Ctrl+V or just choose Paste in the
Office application.

Lock Size of Linked Documents

By setting the size of the linked EcoWin document
in the OLE-link it is possible to keep the size fixed.
The Set Size function can be found in the Window
menu. Please note that users of versions prior to
Reuters EcoWin Pro 5.4 will not be able to open

or update linked documents created in Reuters
Ecowin Pro 5.4. To avoid this, make sure that all
users have the latest version installed.
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Publish - Linking Data into Excel or
EcoWin Documents

The Publish feature is primarily intended for two
purposes:

e Linking time series data into Excel

e Linking time series data into other EcoWin
documents

To make the data available for linking, it must be
published.

1. Select the series you want to publish from either
a table or a chart.

2. Right-click this series and select Publish from the
context menu

"® Reuters EcoWin Pro - [Index builder.ewg]

Eile Edit Analysis Tools Window Help

| BICID[ el A[BICIX] el o] oJos[#[=]]T

Published data can be be used as input

Anal
DELiSES | link can be copied and pasted inta appli

% Before 7 After
Time chart Tahble
£3 Arithmetic ﬂ Performance
% Rate of change ¢y Rebass
-~ Smoathing = Mean

£ Trend Report:

El ﬁ Series List

EE]E Index Builder
-] Report
Tirne chart
Publish

The text in the first column can be edited if you
do not want the suggested text. This text will be
displayed when you browse for series to use as
input in other EcoWin documents, as described to
the right.
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Creating a link to Excel

1. Publish the data you want to make available in
Excel. Note that you can publish more than one
series at a time by marking several columns in a
Table and selecting Publish.

2. Save the document.

3. In alist of published data, select Copy or Copy
Special from the context menu.

4. In Excel, select Paste Special and check Paste
Link.

Using Published Data as Input in Another

EcoWin Document

1. Publish the data you want to make available as
input in other documents.

2. Edit the Description in the first column so that
you can easily recognize this data.

3. Save the document in the EcoWin folder.

This folder is by default located under
My Documents\EcoWin.

4. In the document where you want to use the data
as an input, select Analysis, Add Series and
then select the database Document Database.
You should now be able to find the document
you saved in the previous step.

5. You will now be able to find the document you
saved in step 3. When you select the document,
you can see a list of data published in this
document. Select the data you want to use as
input and click OK.

Another way to create a reference to the published
data is to select Copy from the list of published
data in the first document and then select Paste
Link in the Series List of the new document.



7 Adding analyses

Once you have selected the data you want to work Analyses can be applied on top of each other by
with, an analysis can be applied. The analyses placing the cursor in the Analyses tree where you
available are divided into three different groups; want to insert your analysis. You can also change
Transformations, Statistics and Flow. The groups the order of your analyses by using drag and drop
can be seen by right-clicking on the Series List. in the Analyses tree.

"i" Reuters EcoWin Pro - [EcoWin1. Al =1ol x|
Iﬂ File Edit Analysis Tools ‘Window Help ;Iilll
=1 o o T i S Y Y =P A= EINNNEEREEE
e | | Series and Formulas |F0recasts I Conversion settings I
ME ~ Frequency Include points of observation where data is available for — Currency

© Before (9 After IMonth j IAnyseries j INone -

[E] Time: chart [ Table

£ Arithmetic y,g Performance

2 Rate of change @ Rebase Seriez or farmula |Internal label

= Smoothing — Mean ewiuzal 4057 United States, Government Benchmarks, Inflation-indexed, 10 Year, Yield, Average, USD
7 Trend - Srenario builder

More [+ |

Ll
Copy,
Faste
Faste affer
Fename
( ] Time: chart A
Delete [F] 5catter chart
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Report
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Simnulation » C»Forecast
Skatistics b == Formula
Flow v % Inde builder

Miscellaneous P =Llag

== Missing values
’ Petformance
2 Rate of change
&y Rebase

) Stcalar

% Slicing

= Yield curve
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Transformations

Arithmetic

i
HH

Forecast

=

Formula

Index Builder

il

Lag

Missing
Values

Two time series can be added
to, multiplied or divided by, or
subtracted from each other. The
resulting time series can in turn
be manipulated using the four
arithmetic operators or together
with another time series.

The Forecast analysis adds
forecasted values that you enter to
the end of a time series. By entering
a forecast, you can extend the time
series from the database with your
own future values.

The Formula analysis makes it
possible for you to add a formula at
a specific point in the analysis tree
instead of creating whole formula
series.

The Index Builder analysis can
calculate an index or an aggregate
representing either the value of a
self-financing portfolio of assets, or
the value of a set of assets.

To lag or lead a time series means
shifting the observations of a
chosen time series backward or
forward in time. When a time series
is lagged, it is shifted forwards a
chosen number of observations.
Leading the time series means

the series is shifted backwards a
number of observations.

You can use the Missing Values
analysis to handle missing values in
time series using different methods:
Linear interpolation, Mean, Previous
Value, Quadratic interpolation, or
None.
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Performance The performance of a time series

/

can either be expressed as a
percentage change, or as a change
in the level from a certain date. For
both these kinds of transformations
itis possible to choose a variety

of time intervals over which the
performance calculations can be
made.

Rate of Change A change in a time series can be

%

Rebase

Scalar

¥

expressed either as a percentage
change per period, or simply as

a change in the level. For both
these kinds of transformations it is
possible to express the changes
as an annual rate for both of these
kinds of transformations.

The value of a time series can be
set to a constant, say 100, at a given
point in time. The original time
series is simply divided by the value
at the given point in time and then
multiplied by 100. It is also possible
to rebase a time series relative to
the value of a second time series at
any given point.

The Scalar analysis creates a
number of new series from a set

of input time series. Each new
output series obtains its values
from some scalar function of the
input series. The scalar functions
are observation values at specific
dates or observation numbers, or
the mean, median, performance or
standard deviation of input series
for a specified sample. This function
gives you flexible cross-comparison
possibilities for time series.



Slicing

L3

Yield Curve
P

Simulations
Scenario
Builder

=3

Statistics

Correlation

m

Covariation

oy

With this analysis, you can divide

a given sample of observations
from any number of time series
into smaller samples according to
the criteria of calendar time and/or
number of observations.

Create yield curves based on
natural cubic spline or linear
interpolation methods.

The scenario builder analysis
simulates possible paths for a
time series. Random noise is used
together with a specified path of
future values or a single starting
value to generate scenarios
incorporating uncertainty.

The output series are time series
consisting of quantiles.

The correlation analysis can
calculate correlation functions for
any number of time series.

The covariation analysis can
calculate a number of moving
statistics, i.e. the sample on which
they are based is a time window
with a fixed number of observations.
This analysis is especially useful

for detecting instabilities in
correlations, standard deviations,
and regression coefficients.

Histogram

Mean

Regression

Season

L

Smoothing

g

Trend
o

Use the Histogram analysis to
calculate the cumulative distribution
function or the probability density
function. The output series can

be either in absolute or relative
frequencies.

The mean, median, max or min can
be calculated for any time series. It
is also possible to have confidence
intervals around these calculations.

The regression analysis estimates
a linear regression model with
ordinary least squares (OLS).

The output from this analysis is
estimated parameter values and
their standard errors as well as
overall regression statistics. These
can be seen in a report.

It is possible to use either an
additive or a multiplicative model
for a time series seasonal factor. The
seasonal factors themselves can be
output series.

Various ways of applying moving
averages to any time series: Moving
Averages and Centered Moving
Average, as well as Exponential
Weight and Hodrick-Prescott filter.
This function also allows you to
apply moving standard deviation
(over time).

Reuters EcoWin Pro can plot or
remove certain deterministic trends
from a time series. It is possible to
draw a confidence interval around
the estimated trend.
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Flow

Aggregation Depending on the underlying time

A series’ data frequency, a number
of summation periodicities are
available. The user specifies how
often the aggregation will be
restarted within each year.

Early Warning The user formulates a plan or

ﬁl projection for the present year
concerning this year's sum of a flow
variable. Given the chosen seasonal
model, i.e. additive or multiplicative
model, and the actual development
during the present year up to now,
this analysis estimates whether the
actual development is following
the plan. This estimate can be
formulated in percentages or
values.

Miscellaneous

Stop The Stop selection halts the

= creation of a series at the point at
which Stop was selected.

If you want more information about a specific
analysis, mark that analysis in the Analyses tree and
press F1.
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Reuters EcoWin Pro makes it easy for the user to

make changes to the chart layout.

When a time chart is created, the series are
automatically presented as lines. The tool for
changing the chart layout is the Presentation

settings button.

Graph layout Pane 0

8 Changing the Chart Layout

If you want to remove a series from the chart, use

the right-hand part of the Graph layout box. Just
mark the series and select Delete. The series will

i

—
Z| Production, Overall, Tokal, Yolume, 54, I fl m Im @ I Preview
Z| Leading Indesx, Tokal, 54, Index

Z| Unemployment, Rate, Total, 54

Z| Consumer Prices, All items, Indesx *l

El ~ Lines .
! Production, Overall, Total, Volume, 54, Index
eading Index, Total, 54, Index
nemployment, Rate, Total, 54 — —
Z| Consumer Prices, All items, Index

then be deleted from the chart, but is still available
in the Series list and can be added to the chart
again, using the arrow.

Lol
Cancel
Apply

[elete

L,

Help

RN

A. Series

Shows all series available in the Series List.

o

B. Groups

Shows all series that will be presented in the chart.
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Groups and Series

If you want to change the chart style for all the To modify the settings of a series the series has to
series in your chart, mark Lines and select a new be marked. Selections for color, line style and width
group style for your series. can then be made, depending on type of chart

. . style.
If you want to present one of the series with a y
different chart style, a new group has to be created.
To do this, mark the relevant series in the right-hand
field and select one of the Group icons.

Group icons Series settings

Graph layout Pane 0

éProd.uctlon, Crverall, Total, Yolume, 54, fl Ll-l h" ﬁ II Il [~ Preview o]

=| Leading Indes, Tokal, 54, Index c |
=| Unemployment, Rate, Total, 54 B ~* Lines S
=| Consumer Prices, All items, Indes *l i Productio Apply

Leading Inde:x, Total, 54, Index

Delete

Help

|
Pl

Fore

=
Line style | vl
| —— vl

-

Width

Rl d

V' smooth lines

Marker lﬁ

R
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Load Chart Style

You can use previously saved EcoWin Pro charts as
templates when creating new charts. This choice
is available from the Load chart style drop-down
menu in the toolbar.

A template is created by simply saving the chart. A
number of features of this chart can then be applied
to another chart. The most important properties
are the grouping of the time series, the chart layout
and what can be called ‘user made changes’, such
as the grid, background, the fonts applied to the
value axis and the main title.

Graph layout Pane 0

;Iil_l
|J|--- Load Chart style - J | \l\l | |—|Tm|| ﬂ
United States

v

T T T T T = Cub | |
60 65 0 75 80 g O
Faste
Delete

nployment, Rate' T0t8|, SA Copy chart picture and object

sumer Prices, Allitems, Index

Alternate Scale

The easiest way to display one of the time series

in your chart on an alternate scale, is to right-click
on the time series in your chart, and select Use
alternate scale from the context menu that appears.

You can also create an alternate scale from the
Graph layout box by marking this series and create
a new group. In order to activate the Alternate scale
box, mark the group for the relevant series. The
Alternate scale box can then be marked.

[=l-eh Lines

Leading Inde:x, Total 54, Index Apphy

LLLI :

Delete

Production, Crverall, Total Wolume, SA,

Help

| v Alternate scale |

Publish...

Select Al —
|Graph 1985:2 7,2 Unemployment, Rat e a4

Insert vl

View Ruler
Graph layout...

Wse; main scale

Use alternate scale

Properties... I

Above: Create an alternate scale in Graph layout box.
Left: Create an alternate scale directly in the chart.
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9 Multiple Panes

Itis possible to display several panes in one time
chart. Panes are always inserted below the existing
one and this can be done in several ways: By
dragging and dropping a series outside the graph
area or by using Insert Pane below in the Insert
menu. All panes in a time chart share the same
settings for title, background, range paint and
x-axis. The graph layout is separate, however. Any
pane can be resized relatively by clicking between
two panes and dragging.

All series that are added to a document will
automatically be added to the upper pane only.

The panes support dragging and dropping of
series between them and this is often the fastest
way to add series to a pane. Series can also be
Copied/Pasted between different panes using the
Copy command in the Edit menu.

"® Reuters EcoWin Pro - [USA GDP.ewqg] I |l E

Eile Edit Wiew Insert Chart Analysis Tools Window Help

== x|
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% Rate of change ¢ Rebass

ﬂ Performance
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=
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E
E 1001
«~ Smioothing — Mean g
% Trend 8 954
=
Morebl § 90
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= Series List 20
=% Rate of change
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O
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(At
05
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Il cop 1year
; Source: Reuters EcoWin
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The default chart setting is to chart the data with
full history. If you mark a time series in the chart,
you will find a status field showing the exact date
and value for that point of the series in the bottom
right corner. You can use the right and left buttons
on the keyboard to scroll along the time series and
clearly see the dates and values of the series.

If you have more than one series in a chart, the
Ruler command can be used to display dates and
values for multiple series at the same time.

Horizontal Axis Properties

To edit or view the properties that are specific to
the horizontal axis, you have to double-click on the
X-axis. An X-axis properties box will appear.

Time Axis Layout Horizontal axis
The Display range can be altered to fit your '
requirements. You can choose to either set a
specific date or number of observations.

Several other choices regarding margins and tick
mark position are also available under this tab.

Changes can also be made to the display range
using the Display/Zoom bar available under the
chart. Double-clicking the bar displays the full
length of the series in the chart.

Time Axis Labels Horizontal axis
Automatic

In Automatic mode the purpose is to show as much
information as possible. When this mode is turned
off, you can manually enter the distance between
each minor tick mark.

Include Century
When this option is marked the years will be printed
with four digits, e.g. 1998.

10 Chart Properties
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Vertical Axis Properties

To add new settings to the Y-axis, double-click
on the vertical axis and enter your settings. The
preset mode is always Automatic which means
that EcoWin Pro will find the most suitable scale
for the series included in your chart. The Y-axis can
be reversed, duplicated on the right-hand side or
recalculated to a logarithmic scale. If automatic is
turned off, you have the option of entering your
own values for Top, Bottom, Step, Decimals and
Scaling.

Main vertical axis

Scaling
Scaling allows you to change the scale of the time
series in a chart according to your own preferences.

The text on the Y-axis will change according to your
selection. u
u
u
Title

Double-clicking on the title in a chart allows you to

easily change the chart's titles and fonts. -

United States
Leading Indicator and Industrial Produckion
=}
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Chart Settings

Double-clicking directly in the chart allows changes
to be made to the grid lines as well as the horizontal
and vertical axes. Changes can be made to titles,
background and range paint from the Chart
settings command in the Chart menu. In addition,
the color for the graph area can be set separately.

Time Series Properties

Double-clicking on one of the time series in a chart
will bring up the properties of the specific series.
Changes can be made to line style and width, for
example, from this box. You can also see which
analyses have been applied to the specific time
series, and the analyses applied can easily be
changed from here.

Leading Indicator

certer [}
certer [}

certer [~}

Fill J
il devr J
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Lines, Arrows and Text
You can add labels, lines and arrows to the chart
simply by clicking on these buttons in the toolbar,

and pointing and clicking where you want it to USA, Leading Indicator =]
appear in the chart. Double-click on the object to _

set the font, color and style. In addition, you can 2
apply multiple lines to text labels.

To edit the properties of text inserted in the chart,
double-click on the text; the Label Properties box
will appear.

Objects can be moved from their initial locations. Line or Arrow
When using Print preview you will be able to see |
how the text fits into the chart. By marking the
object once, a small square becomes visible and
you can move the object by holding down the left
mouse button and dragging the object to another
part of the chart.

Lines, arrows, and text boxes are anchored
horizontally and vertically by default. This means
that lines, arrows and text will be relative to the

x- and y-axis. If unmarked, these will be relative to
the chart window. If you want to point out a specific
value in the chart, anchoring is recommended.
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Use the Excel Add-in to download time series
data directly into Excel spreadsheets. The add-in
consists of two parts: the Time Series module and
the Equities module; while the former allows you
to work with all sorts of data, the latter is designed
specifically to handle equities-related data.

A. Toolbar Buttons
The toolbar buttons provide a quick way of accessing
the Time Series and Equities wizards, as well as the
online Help.

B. Download Time Series Data to Excel
Time series - This will open the Time Series window,
through which you can select and download time
series data.
Properties - Here, you can change the settings of one
or several selected time series, and even replace the
entire time series.
Load data - Opens up the Time Series wizard for all or
a selection of series.
Convert old sheet - Convert spreadsheets from
EcoWin Graphics format to EcoWin Pro format.

C. Download Equities Data to Excel
Equities - Download equities data. This will open the
Equities wizard.
Edit Worksheet - Load content from the spreadsheet
into the Equities Wizard for editing.
Convert Values - Convert from dynamic values to
static ones, or vice versa.
Show Series Info - Present information about a
particular time series.
Open Select Series - Browse for time series using the
Select Series interface.

D. Update
Update - Updates a sheet, a selection of series, or the
entire workbook.
Requery - Re-runs the query originally used to create
a particular EcoWin Equities output region. This may
cause the entire region to shrink or grow.

11 Excel Add-in

ormat  Tools  Data  Window | EcoWin IHeIE

?:i:& % Ea@- f gg Time Series... 1100%

A Properties 3
Load data 3
@ Convert old sheet...

| D | E | E.; Equities. ..

Edit Worksheet
Convert Yalues 3
@  show Series Info

Open Select Series

Update 3

Requery 3

Preferences. ..

Export ko In-House 3

@ EcoWin Add-In Help
EcoWin Pro on the Web

Coptact Us

00006 0 ©

About Ecoin Add-In

. Preferences

Allows you to change the preferences settings for the
Excel Add-in.

. Export to In-house

With this feature you can define a set of time series in
Excel and export the data to your in-house database.

. Help and Miscellaneous

EcoWin Add-in Help - Display the software
documentation set.

Reuters EcoWin Pro on the Web - Start an Internet
browser, and direct it to the EcoWin web site.
Contact Us - Send your query directly to Reuters
helpdesk by using the Contact Us form.

About EcoWin Add-in - Display additional
information about the software.
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Working with Time Series Data

Select ‘Time Series..." from the EcoWin menu. This will open the Time Series window, as shown below.

" Ecowin - Time Series

= 3]
Series
| e gbr1 4020

General | Walues I Rate of change | Hebasel Smaothing I

From To Type Observation
[5TeRT = st I =l
Frequency Cony. Method

I Mone j IAuto j .

Currency Mizzing values

[ None 2 I e |

[~ Donot show dates [~ Use scale factar

Get zettings | Fieset | Apply to all Apply to zelection |
Series or Formula | Diescription | Frequency | Cony. Frequency ;I
ewgbrld110 United Kingdom, Government Benchmarks, 2 year, Yield, Cloze, GEP Day Day _I
|| ewgbr1d140 United Kingdom, Gavernment Benchmarks, 20 year, Yield, Claze, GEP Day Diay
ewrgbr14103 United Kingdom, Interbank Rates, LIBOR 3 month, Fiking, GEP Day Day _ILI
b4 | BREVEETS T T A e T S U e e N T WAL Ple.o CRO P R
3

[~ Exportto new sheet [ Export asrows [ Do not export dates

[ Close on export [ Orie date cal/raw

Export to Excel |

Help I Clear | Dpenl Savel

Cloze "

() ()

A. Selecting Series

Before you can export any data to Excel you first
have to select a number of time series. There are
several ways to do this:

You can enter a series code directly into the Series
text box, and press the Enter key.

You can also press the Select Series button,

which brings up the Select Series dialog. Use this
interface to browse your databases, and pick series
using the Text Search or the Tree View. Multiple
series can be selected.

Finally, you can press the Formula Editor button,
and enter simple arithmetic expressions.

@ Reuters EcoWin Pro — Quick Start Guide

(€]

B. Series Settings and Analyses

The Series settings — such as display range,
frequency and other parameters — can be modified.
To the left-hand side there are general settings,
and to the right you have a number of analyses.
The settings you specify will then be used for every
series you add to the Series List. To change the
settings for one or several of the series in the Series
List, use the Apply to selection or the Apply to all
buttons.

You can change the settings of the series manually
or copy the settings from any of the series already
present in the Series List. To retrieve the settings



from a series in the Series List, select the series and
then click Get Settings. To assign default values to
all settings and analyses, click the Reset button (this
action will not affect the series in the Series List).

Settings — General tab

From — Start of display range. Can be set to:

o LAST
Shows the latest observation available in the
database.

e START
From the actual beginning of the series. This is
the default setting.

e Number of observations
The number of observations prior to the latest
one, e.g., -10 or -200.

e Custom date
A normal date. Short date format should be used
(c.f., Regional Settings in Windows).

e Calendar period
Used when a specific calendar period should be
displayed, e.g., -1M or -1Y.

To — End date of Display range. Can be set to:

e LAST
Shows the latest observation available in the
database. This is the default setting.

e TODAY
Shows all observations up to today. Useful when
you want to apply a common end date to all
series.

e Number of observations
The number of observations prior to the last one.

e Custom date
A normal date. Short date format should be used
(c.f., Regional Settings in Windows).

e Calendar period
Used when a specific calendar period should be
displayed, e.g., -1M, -1Y, +1M, or +1Y.

Frequency - Select the frequency to which you
want to convert the data.

Conversion method - Select the frequency
conversion method, if any.

Currency — Select the currency in which you want to
express the series.

Missing Values — Defines how non-existent
observation values should be handled.

Default is N/A, but can be changed to Previous
Value or Empty.

Do Not Show Dates — If this is marked, the series
will not show any date columns.

Use Scale Factor — If this is marked, the Scale
factor will be used and all digits will be displayed in
Excel.

Settings — Value tab
Lag Observations — The number of steps to shift
the time series observations forward or backward.

Analyses

There are three different analyses available

- Rate of Change, Rebase, and Smoothing. Rate
of Change and Rebase also support a number
of different variants. Note that you cannot apply
more than one analysis per time series. For more
information on analyses and the parameters they
accept, please refer to the online User Manual.
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C. Series List

Changing Order of Series — Use the Up and Down
arrows to change the order of series in the Series
List.

Series Selection — Changes can be applied to

a selection of series in the Series List. To apply
the current settings, click the Apply to selection
button, or use the Apply to all button.

Series Properties — To change the properties of a
single series in the Series List, you can double-click
it. This will display the Properties dialog for the
selected series. Properties can also be accessed
by right-clicking the series and selecting the
Properties menu item, or by pressing the Enter key.

Copy and Paste — Select one or more series in the
list, then right-click. From the context menu, you
can choose one of the standard Copy and Paste
items. By using those commands you can move
collections of time series identifiers between the
Series List and other applications, such as EcoWin
Pro or Notepad.

Delete — Pick some series in the Series List and
press the Del key, or right-click and select the
Delete menu item.

D. Export Options
Export to Excel - Exports the content of the Series
List to Excel.

Export to New Sheet — Exports series into cell Al
in a new spreadsheet.

Export as Rows — If this is marked, series will be
exported into rows instead of columns (the output
will be transposed).

Close on Export — Closes the Time series window
after export is completed.

Do Not Export Dates - If unmarked, one date
column will be exported for each series. If marked,
no date columns will be exported.
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One Date Col/Row - If checked, only the date
column for the first series will be exported. This
option is only available if all series share the same
Start date, Frequency and Last date. To ensure that
the last date is the same, set To = TODAY for all
your series.

E. Series List Commands
Clear — Clears the Series List, and resets the
settings and analyses to their default values.

Open/Save — Load or save the contents of the
Series List from or to disk.

Close — Close the Time Series wizard window.



Series Properties

After you have exported your time series data able to right-click a cell containing a time series
to an Excel spreadsheet, you can use one of the identifier in the Excel spreadsheet to access the
Properties menu items to change the settings same dialog.
of one or several time series. Depending on your From here, the settings of individual series can be
Macro Security settings in Excel, you may also be changed, and series replaced.
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Draw= l; | Autoshapes~ ™\ ERIR = A | &
raw T L utoshapes OO B i 4 22 8] & |ew:gbr14140 il 1'
Series description

IUniled Kingdom, Govemment Benchmarks, 20 year, Yield, Close, GEP

Original Frequency Convert to Frequency
|Day |Day |
Currency

IGBF’ vl [+ Do nat show dates
Source:  Reuters Info... |
Update | Update All | Cancel |
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Working with Equities Data

Using the Equities wizard you can easily download
equities data into Excel — e.g., this can be historical
data or estimates, for prices and for fundamentals..
Itis a tool that lets you create and edit dynamic and
static equities data.

The wizard provides you with an easy way of picking
the companies (and/or indices) and data items

you are interested in, and offers a wide variety of
formatting options.

Company and Index Selection
Select ‘Equities..." from the EcoWin menu.

1. Look up companies or indices either by using
keywords (searching by name, ISIN or RIC) or by
browsing through the tree structure.

2. Pick the companies you are interested in, and
add them to the Selection List.

3. Click Next to proceed to data items selection.

CoWin - Equities Ol =|
Company/lndex Selection
Wiew | Kepwords
IEompanies by Country j
- Russia ;I Company/lndex [428 entries] | |:|
- Singapare HEBA, Fastighets SE
- Slovak Republic A auritz ]
- Slovenia Hexagon i
- South Afica Hill International
- South Korea HL.D'SDla}' : |
S i Hoist International
iahal | EHolmen
- Gweden Home Properties
- Switzerland HG Fonder
- Taivan Hufvudstaden
o Turke = Human Care HC
Y | Hiinanss or U
Look Up | Add All | Mone | Inxert |
r— Selection List
Dfl fow =1 4| v|<]>| x|ml] »l7] G 4
: Datalters 0
Company/lndex Ma... |
Alfa Laval
Ericsson
Hennes & Mauritz
Holmen
‘warning: Data may only be uzed on licensed Ecowin workstations < Back Mext > Export
1§
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Data ltem Selection
1. You will have four different categories of

data items to choose from: Attributes, Prices,
Fundamentals and Estimates. (The Estimates tab
will only be available to subscribers of estimate
data).

Attributes — allows you to choose items such

as the country of origin and different industry
classifications.

Prices — close, high, low, volume, etc.
Fundamentals — choose variables from Balance
Sheet, Income Statement, Cash Flow Statement
and Key ratios.

Estimates — select the estimates of interest such

Select the data item you are interested; you

can then decide to apply one of the available
analyses, such as Rebase or Performance. When
clicking the Add Item button you will get the last
value of the series, while Add Range allows you
to choose a time range, that is, it will help you
create several, consecutive observations at the
same time.

. The selected data items are now added to the

companies in the Selection List, and you can
select another data item.

Note that you cannot change the settings of the
data items that have already been added to the

as EBIT Median, Sales Median, etc. Selection List.

" EcoWin - Equities ol =|

[ ata ke Selection

Attributes  Prices |Fundamentals| Estimatesl ettings
~
Open Rebase, Absolute ~

Rebase, Relative
Performance, Value LI

Fieference Time:

— |l

harez Outstanding Fiebaze Factor:

Tumnover |1 o0 Currency:

Reference Series: |L0c:a|

[ HEl |
ean/tinddaq Fanae:
From:

[~ Export Last Date i

[ Export Original Frequency Iﬁ_l
Addltem | AddRange

[ Ezport Original Currency

— Selection List
- = 2 Companies 4
D|D|ﬂ| I[None] j “l‘l‘l’l Xlglwl Hl‘/ Dataltems 4
Company/Index Na... | Open @ [Last] | High (3 [Last] | Lo (& [Last) | Cloge @ [Last
Alfa Laval dzalfa_st_op dzalfa_st_hi dzalfa_st_lo dzalfa_st_cl
Ericszon dzenic_b_st_op dzenic_b_st_hi dzenc_b st lo dzenc_b_st_cl
Hennes & Mauritz dzhm_b_st_op dzhm_b_st_hi dzhm_b_st_lo dzhm_b_st_cl ~
Holmen dzhaolm_b_st_op dzholm_b_st_hi dzholm_b_st_lo dzholm_b_st_cl
| | B
‘Warning: Data may only be uzed on licensed Ecowin workstations < Back Mext > | Export |
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Presentation Settings

Once the data items have been selected you have
several options for how to present them. You can
Target the data, meaning that the data can be
downloaded to your current worksheet, or a new
one, and you can also direct the output to start at
any cell you choose. Customized Formatting allows
you to choose between several different formatting
schemes.

Export your data selection to the assigned book,
sheet and cell, and in the format selected, by
clicking the Export button.

After you have downloaded data into Excel it is
possible to change, for example, the currency of a
particular data item. Do this by going to the EcoWin
menu, and select Edit Worksheet.

=" EcoWin - Equities

Current book, new sheet |—

Regions

All equities data will be exported to Regions, and
this enables you to export data several times to the
same worksheet. Later, when you want to edit your
data, you will be asked which region you want to
modify, and this data will then be loaded into the
Equities wizard.

You can also ask the system to Requery for data,
which is useful if you want to update for example an
Index Constituent List. Such a list is then allowed to
grow or shrink depending on whether companies
may have dropped out or been added to the index.
Note that this is conceptually different from a
normal Update operation, which will only update
the data for companies already present in the
spreadsheet.

(=[5

More) =]
[

— Selection List

Dfsl@ fow =1 4[v|<|>| x|mlm] o|7] G 4

: Dataltems 4
Compary/ndex Na... | Open @ [Last] | High & [Last] | Low @ [Last] | Close @ [Last
Alfa Laval dzalfa_st_op dzalfa_st_hi dzalfa_st_lo dzalfa_st_cl
Ericzzon dstenic_b_st_op dzenic_b_st_hi dzenc_b_st_lo dzenic_b_st_cl
Hennes & bauritz dzhm_b_st_op dzhm_b_zt_hi dzhm_b_zt_lo dzhm_b_zt_cl
Holmen dzhaolm_b_st_op dzholm_b_st_hi dzholm_b_st_lo dzholm_b_st_cl

Wwharning: Data may only be uzed on licensed Eco'win workstations
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12 Creating In-house Time Series

Reuters EcoWin Pro can be integrated into your 1. Give your series a name.
own data, for example, your company's in-house 2. Select start time for the series.
tracking of sales of various products, \{olu.me or 3. Select frequency and optional currency.
other data sets relevant to your organization. 4. Type a description for the series.
If you want to create your own time series, you can 5. In order to easily find your in-house series, select
do this using the Series editor. The Series editor country and category.
can be found in the File menu, Series editor, New, 6. Save your series.
Series.
Note that if you use Excel, you can also use the
Reuters EcoWin Excel Add-in to create and edit in-
house time series data.
(MNewseries x|
Database iIn-house 'l
|ﬂame
||M_l,l senies [a-z. &2, 0-9 and _ are allowed in series name]
Start time: Frequency Currency
[2000.01-03 Day =] ]
|Qescription IU_S. Interest rate |——°
Source |
Copyright |
Comment ;I
Country IUnited States j e
Cateqgory IBond M arket j
Order priority iD
Scale [recimalz Unit Llazz
ID i‘l IPercent IF'rice ;i
o S o
4
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Type data into the data column or use standard To retrieve your In-house series, select In-house
Windows commands, i.e. Copy and Paste. from the drop-down menu for Database. Search in
the In-house database using the same criteria as for

If you want to make changes to your In-house the EcoWin database.

series, choose File, Series editor, Open, Series.

Reuters EcoWin Pro - [ih:My_series]
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DDE is a way to transfer data to other Windows
applications. Reuters EcoWin Pro supports DDE
links to data in the EcoWin databases to make it
possible to use this data in applications such as
Microsoft Excel. When the data is updated in the
database, any data that uses DDE links is also
updated automatically.

An easy way to create a DDE link is to copy the

link information to the clipboard from a chart in
Reuters EcoWin Pro. Please note that DDE linking
can only be implemented before any analyses

are added. Select a value by clicking on a graph,
then copy (using the Copy command in the Edit
menu, the toolbar, the context menu or by pressing
Ctrl+C). In Microsoft Excel, select a cell and mark
the Link option in the Edit menu, Paste Special
dialog box. No analyses performed for the series
will be included in the link, and some analyses even
prevent links from being created, since there is no
obvious way to determine what the original series
or formula was.

13 DDE Linking

Below are a few examples of DDE links for Excel:

EcoWin|Expr!’ew:swe19001’
The last value of the series ew:swe19001.

EcoWin|Expr!’ew:swe19001[-1]"
The second to last value of the series ew:swe19001.

EcoWin|Expr!’ew:swe19001/ew:gbr19001’
The last value of the formula ew:swe19001/
ew:gbr19001.

EcoWin|Expr!’ew:swe19001[-3,0]’

The last four values of the series ew:swe12001.
To enter a vector expression like this in Microsoft
Excel, mark four cells, enter the expression and
then press Ctrl+Shift+Enter.

EcoWin|Date!’ew:swe19001"
The date of the last observation of the series ew:
swel19001.
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Further Assistance

Reuters EcoWin Pro Help

Reuters EcoWin Pro contains comprehensive

help documentation. Within this you will find
descriptions, definitions, formulas and examples.
Simply mark an item and press F1 on your keyboard
or click on the Help button in the toolbar.

Reuters EcoWin Excel Add-in Help

The help for the Reuters EcoWin Excel Add-in is
available in the EcoWin menu in Excel and contains
a quick start guide, user manual, and reference
manual.

Reuters Customer Zone

Technical and user documentation is available

on Reuters Customer Zone. This site includes
information for contacting Reuters support either
online or by local telephone.
http://customers.reuters.com

Customer Support
For local telephone numbers please see:
http://customers.reuters.com

You can send your query directly to the Reuters
helpdesk by using the Contact Us form available in
the Help menu of the application.

For more information:

Send us a sales enquiry at
www.reuters.com/salesenquiry

Read more about our products at
www.reuters.com/productinfo

Find out how to contact your local office
www.reuters.com/contacts

Access customer services at
www.reuters.com/customers

Reuters uses your data in accordance with Reuters
privacy policy in the privacy footer at www.reuters.
com. Reuters Limited is primarily responsible

for managing your data. As Reuters is a global
company your data will be transferred and available
internationally, including in countries which do

not have privacy laws but Reuters seeks to comply
with its privacy policy. If you wish to see or correct
data held on you or no longer wish to receive
information about developments in Reuters Group
products and services, such as free trials or events
or you wish to change your preferred method of
receiving a communication, please email esupport
global@reuters.com writing “Personal Details” in
the subject line
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REUTERS/Paul Matthews

Pilots fly their paragliders during day one of the 10"
World Paragliding Championships in the skies above
Manilla northwest of Sydney February 27, 2007.

The competition has attracted competitiors from 45
nations and lasts two weeks.
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